ViewSonic
Pocket PC V36

ViewSonic




Copyright © ViewSonic Corporation, 2004. All rights reserved.
ViewSonic and the three birds logo are registered trademarks of ViewSonic Corporation.

Microsoft, Windows, the Microsoft Internet Explorer logo graphic, ActiveSync, PowerPoint,
Outlook, DirectX, DirectSound, Pocket Word, MSN, Pocket Excel, Pocket Internet Explorer,
Microsoft Exchange, Visual Solutions, and the Windows logo are either registered trade-
marks or trademarks of Microsoft Corporation in the United States and/or other countries.
ClearVue is a trademark of the Westtek Corporation.

Corporate names and trademarks are the property of their respective companies.

Disclaimer: ViewSonic Corporation shall not be liable for technical or editorial errors or
omissions contained herein; nor for incidental or consequential damages resulting from
furnishing this material, or the performance or use of this product.

In the interest of continuing product improvement, ViewSonic Corporation reserves the
right to change product specifications without notice. Information in this document may
change without notice.

No part of this document may be copied, reproduced, or transmitted by any means, for any
purpose without prior written permission from ViewSonic Corporation.

Product Registration
To meet your future needs, and to receive any additional product information as
it becomes available, please register your product on the Internet at:
www.viewsonic.com.

For Your Records

Product Name: ViewSonic Pocket PC V36
Model Number: VSMW27026-1

Document Number: A-CD-PPCV36-UG Rev. 1B
Serial Number:

Purchase Date:

ViewSonic Pocket PC V36



ViewSonic Pocket PC V36



Product Registration .............oooieiiiiiiii e [

FOr YOUr RECOIAS .....eviiiiiiiiiieie et i
Getting Started
Package Contents ... 1
ACCESSOMES ..eiiiiiiiiiie ittt e 1
QUICK START .ottt 2
1 Identifying Components ........cccocceeeeiiiieee e 2
2 Installing the Battery ..., 3
3 Charging the Battery .......ccccoviiiiiiiiiiee e 4
4 Starting YOUr V3B .......ooviiiiiiieeeiiiee et 4
5 Installing Microsoft ACHIVESYNC ......ccooceeeveiiiiiiieieee e, 5
Register Your Product ... 6
For More INformation ..........ccoooiiiiien e 6
Hardware Features ... 7
Front COmMpoNents ........ccceviiiiiiiii e 7
Rear ComponENnts ........ceeiiiiiiiiiee e 8
Left-Side Components ..o 9
Right-Side Components .........cccccooiiiieiie i 10
TOP COMPONENES ..ot 11
Bottom Components ........c..oooiiiiiiiiiiiii e 11
V36 USB Cradle ......cceuvieiiiiiiiieieiiiee e 12
Battery Charging OptioNS ........eoeiiiiiiiiiiiiiiiee e 13
SD Memory and SDIO Capabilities .........cccoceviiiiieiiiiieee e, 14
Basic Skills
USING the SEYIUS ..oooiieiiee e 15
Using the Integrated Digital Camera ........c.ccooieieiiiiiene e 16
Basic Camera FUNCLIONS .........occuieiiiiiiiiiiciee e 16
TOAAY SCIEEN ..eeiiiiiiie e e 17
StAtUS ICONS .o 18
Navigation Bar and Command Bar ..........ccccoecveieeeiiiiieneiiiieeenn, 19
RUNNING Programs .........coooiiiiiiiiiiee et 20
POP-UP MENUS ... e e e e e e e e e e ee e e e eeeeeeeaens 21
NOHFICAtIONS oo e 21
Entering Information ..........ccccoiiiiiiii i 22
Entering Text Using the Input Panel ...........ccoooiiiii 22
Writing on the SCreen ... 25
Drawing on the SCreen .........ocueeeiiiiiiiiiiii e 28

ViewSonic Pocket PC V36 iiii



Recording @ MeSSage .....cccuuuviiiriiiiiieeeee e 29
USING MY TeXE ..o 30

Managing Your V36

Managing POWET ... 31
Power-Saving TiPS ..ooccveeeieiiiiieie et 31
Managing MEemOIY .......cooiiiiiiii e e 32
Storage and Program MemOry .........oocveeviiiiieieniiieeee e 32
MemMOry Cards .........eeiiiiiiiiiie e 32
SDRAM Memory AlloCation ..........cooiiiiiiiiiiiiieee e 32
Finding and Organizing Information ...........ccccocviiiinininiee e 33
Customizing YOUr V36 ....ccoooiiiiiiiiiiiieee e 34
Setting @ PassSWOrd .........cooiiiiiiiiiiiiiiee et 35
Adding or Removing Programs .........cc.ceeeeiiiiieniniieeie e 35
Adding Programs .........coooiiiieiiniiiee e 35
Removing Programs ... 35
Backing Up Data .......cooouiiiiiieieeeee e 36
USING BACKUP e 36

Microsoft ActiveSync

Using Microsoft ACHVESYNC .....ccceeeviiiiiieieeeee e 39
Synchronizing Data ........cc.ceoiiiiiiiii e 40
Connecting 10 YOUr PC ..o 41
Connecting by USB Cable .......cc.ceeiiiiiiiiiiiiiiieee e 41
Connecting by Infrared .........coooiiiiiiiii e 41
Pocket Outlook
Scheduling Appointments/Meetings ........cccccevviiieeiiiiieeee e 43
Creating an Appointment .........ccccceviiiiiie e 44
Using the Summary SCreen ........coccveeviiiiiiie e 45
Creating Meeting ReqUESES ........eeeviiiiiiiieiiiiiee e 45
Managing Contacts .........oocceiiiiiiieie e 46
Finding @ Contact ..........eoiiiiiiiiii e 47
Using the Summary SCreen ... 48
Tasks: Keeping @ To DO LiSt .......oeeiiiiiiiiiiiiieeeee e 49
Creating @ TasK ....ccceeeiiiiiiiee et 50
Using the Summary SCreen ........coocveeviiiiieie e 51
Notes: Capturing Thoughts and 1deas ...........cccceeeiiiieeeiinieee e, 52
Creating @ NOtE ....cceeiiiiii e 52

iv ViewSonic Pocket PC V36



Inbox: Sending and Receiving Email ........cccooocieviiiiiine e 53

Synchronizing Email Messages ........ccccoveeeeveeiiiieieiiiieee e 53
Using the Message List .......ooooiiiiiiiiiiii e 53
Managing Email Messages and Folders ..........cccoociuiiiieieennnnnn. 55

Companion Programs

POCKEt WOKd ... 57
Using Pocket WOrd .......coooi i 57
Tips for Working in Pocket Word .........cccoccveviiiiiene e 58

POCKET EXCEI ... 58
Tips for Working in Pocket EXCel .........ccooviiieiiiiiiieiiiiieeeeee 58

Windows Media Player for Pocket PC ..........ccccceiiiiieniiiiiieee e, 59

Microsoft REAEr .......oocuuiiiiiiiiiiei e 60
Getting Books onto YOUr V36 ......c.ceeeviiiiiieiiiiiiiiee e 60
Using the LIbrary ... 61
Reading @ BOOK .......cccooiiiiiiiiiiie et 62
Using Reader Features ...........ccccooivieiiiiniiiee e 62
Removing @ BOOK ........oocueiiiiiiiiee e 63

Other Programs .......ooiiiiiiiiieiiiiiie et 64

Pocket Internet Explorer

Using Pocket Internet EXpIOrer ..........ooooeviiiiiiieiiiiieee e 65
Viewing Mobile Favorites and Channels ............cccocceeiniineenn. 66
Browsing the Internet ... 66

The Mobile Favorites Folder ..o 66
Favorite LINKS ......occiiieiiiieie et 67
Mobile FAVONLES .......coeiiiiiiieee e 67
Conserving MEMOIY .....cooiiiiiiiiiiiiiiee e 67

Using AvantGo Channels ..o 68

Getting Connected

Connecting to a Network or the Internet .........cccoociiiiiiieen, 69
Using an Infrared ConNection ..........cccoiiieiiiiiiiien e 72

Troubleshooting and Maintenance

Resetting the V36 (warm boot) ........ccoooceiiiiiiiiii e 73
Restoring Factory Defaults (cold boot) .........ccoceveviiiiiniiiiiiieeee, 74
Power Problems ... 76

ViewSonic Pocket PC V36 v



Memory Problems ... 76

SCreen ProblemMS ... .ooeeieieeeeeee e 77
Connection Problems .........ooiiiiiiieieiiee e 78
USB Cradle Connection Problems ..........ooeeeiiiiiiiceeiieeeeeen. 78
Network Connection Problems ............oviiiiiiiiieiieeeieeeeees 78
Infrared Connection Problems ..., 79
Care and MainteNanCe ........ccccoeeieeeviiiiiiieeeee e 79
General GUIAEIINES .......uiiiiiiiiiee e 79
Travel GUIdEIINES .......ueeiiieieeee e e 79
CUSIOMEr SUPPOIT ... 81
Appendix
Regulatory and Safety Information .........ccccoovvieiiiiie e, 83
Class B ReguUIAtiONS ........c.eeeeiiiiiiieieiiieee e 83
European Regulatory NoOtiCe ... 84
Battery Replacement ... 84
About the AC AdAPLEr .....uvviiiiieee e 85
About Electrostatic Discharge ..........ccccceeeeiiiiiiiniiiiiieeeeeeeen 85
Limited Warranty .........ooooiiiie e 86
SPECIfiICAtIONS ...uviiiiiieeii e ———————— 87
Data LOSS DISCIAIMET .....uuiiieiieeeeeeee e 88

vi

ViewSonic Pocket PC V36



Bl Getting Started

Congratulations on your purchase of the ViewSonic Pocket PC V36. The V36 is a
Windowse Powered Pocket PC that enables you to keep your most important
business and personal information up-to-date and close at hand. Microsofte
ActiveSynce increases the power of your device by allowing you to synchronize
information on your desktop or laptop computer with your V36.

This chapter introduces you to the internal and external components of the
ViewSonic Pocket PC V36.

Package Contents

When you unpack the contents of the Pocket PC V36, verify that you have all of
the items listed below.

¢ ViewSonic Pocket PC V36

e Stylus

e Lithium-ion battery

e AC Power adapter

e USB Synchronization cable

e SD dummy card (inside the slot)
e Carrying case

e ViewSonic Pocket PC V36 Companion CD (contains Microsoft ActiveSynce,
Microsoft Outlook 2002, ClearVue Presentation, and the V36 User Guide in
PDF format)

e User Guide

Accessories

You can expand your V36’s capabilities or replace lost parts by purchasing
accessories. Here are some of available accessories:

e USB cradle
e Lithium-ion battery

ViewSonic Pocket PC V36 1



e ViewSonic 802.11b SDIO card

* Travel Kit (AC Power adapter and USB Synchronization cable
e AC Power adapter

e USB Synchronization cable

e Stylus (pack of 3)

e Screen protectors (pack of 5)

Visit www.viewsonic.com for information about V36 accessories.

QUICK START
Using the V36 for the first time

1 Identifying Components

SD/SDIO Card Slot

Infrared (IR) Port M Stylus

Notification Indicator (Red)
Battery-Charging Indicator —|
Lanyard Eyelet 2o aad
Power Button

Record Button !

s |

Touch Screen

| 3— Battery Compartment
Lock; Locked (up)/
Unlocked (down)

Headphone
Connector . 3

Microphone l L—————  Speaker

Program Buttons (4)

i

Navigation Pad/ Select
(camera button)

USB Cradle Connector I Power Connector

(connect to AC adapter)

2 ViewSonic Pocket PC V36



2 Installing the Battery

To install the supplied lithium-ion battery, do the following:

@ Make sure that the V36 is turned off, then slide battery lock switch to the
unlocked (down) position. See the illustration below.

@ Remove the battery compartment cover.

@ Insert the battery into the battery compartment.

O Unscrew the cap at the top of the stylus.

@ With the battery switch in the Off position, charge the battery for 24 hours.
To charge the battery, you have three options: (1) connect the AC adapter
directly to the bottom of the V36, (2) connect the AC adapter to the USB
Synchronization cable, then to the V36, or (3) connect the V36 to the cradle
(purchased separately), then to the AC adapter.

@ After 24 hours of battery charging, use the pointed tip of the cap to slide the
battery switch to the ON (right) position.

@ Replace the battery compartment cover.

O Side battery lock switch to the locked (up) position.

The Notification indicator will flash red for approximately 30 seconds, and
then your V36 will automatically turn on and display the Welcome Wizard

|~
% e Replace battery
compartment cover
] -

]

screen.

Remove battery
compartment cover

IMPORTANT: Unless you need to restore factory defaults (cold boot),
keep the battery switch set to ON (left position). Performing a cold
boot (setting battery switch to Off, then to On again) will erase all files
stored in SDRAM memory. See page 74, Restoring Factory Defaults
(Cold Boot) for more information.
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3 Charging the Battery

To connect your V36 to an AC power source, do the following:

@ Insert the DC end of the AC adapter cord into the power connector at the
bottom of the V36. (See illustration below.)

@ Plug the other end of the AC adapter into a grounded AC outlet.

Battery
Charging Pocket PG St
Indicator

ViewSonic

The battery-charging indicator lights amber when charging is in progress.

1 Fully charging your V36 may require up to three and one half hours. The
battery-charging indicator turns green when the battery is fully charged.

IMPORTANT: The first time you charge the battery, charge it for at least 24
hours. When charging the battery for the first time, be sure to leave the
battery switch in the Off position. After 24 hours move the switch to
the On positon. This will insure that the small backup battery inside the V36
is fully charged.

NOTE: Whenever possible, charge the battery by connecting the V36 to an AC
power source. This will keep the battery charged and prevent data loss or
damage to the battery in case the battery has been kept in a discharged state
for too long.

4 Starting Your V36

Press the power button to turn the V36 on.

The first time you start your V36, the Welcome Wizard screen appears. The
wizard's on-screen instructions will lead you through the setup process. Follow
the instructions to complete the process and begin using your V36.

4 ViewSonic Pocket PC V36



5 Installing Microsoft ActiveSync

A key component of your V36 is the Microsoft ActiveSync® program. With
Microsoft ActiveSync, you can synchronize the information on your PC with
information on your V36 and update both with the most recent information.

ActiveSync is already installed on your V36. You need to install ActiveSync on
your PC. Follow the procedure below:

IMPORTANT:

¢ Before installation, make sure you have Microsoft Outlook installed
on your PC. If you do not have Outlook, you can install Outlook 2002
from the provided ViewSonic Pocket PC V36 Companion CD.

e Do not connect your V36 to your PC before ActiveSync is installed.

1 Turn on your PC.

2 Insert the Microsoft ActiveSync Utility CD into the CD-ROM drive of your PC.

The ActiveSync installation screen should open immediately. If this does not
happen, double-click Setup.exe and go to Step 3.

3 Click the arrow on the first screen to enter the main screen. Click Start
Here, then click Install ActiveSync 3.7 (or a more recent version).
Click Install to start the installation.

4 When prompted, connect your V36 to your PC using the USB synchronization
cable as follows:

(1) Connect the AC adapter to the power connector on the USB plug.

(2) Connect the USB synchronization cable to your V36, then connect the
USB connector to your PC. The Found New Hardware Wizard will
appear.

ol P

M

A -0

e e

@ %
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5 Follow the on-screen instructions to synchronize the V36 with your PC.

After your first synchronization, the data you have stored on your PC, such as
Calendar, Contacts, and Tasks, is copied to your V36. You're now ready to take

it along with you when you go. For more information on ActiveSync, see

Chapter 4.

Register Your Product

Go to www.ViewSonic.com\support\prodreg.htm to register your V36.
You will need to know the serial number of your V36 (see the back of the V36).
To help with identification in the event of theft or loss, keep this User Guide as
a permanent record of your purchase.

For More Information

Information Source

Complete information for operating the
V36

V36 User Guide (In addition to the paper version, the User
Guide is also available as a PDF file on the ViewSonic Pocket
PC V36 Companion CD.)

Programs on your Pocket PC

V36 User Guide or ActiveSync Help on your PC.

Additional programs that can be
installed on your Pocket PC

ViewSonic Pocket PC V36 Companion CD

Connecting to and synchronizing with
aPC

V36 User Guide or online Help. Tap Help on the Start menu to
view Help.

ViewSonic Customer Support

Chapter 9 of the V36 User Guide

Troubleshooting

V36 User Guide

Last-minute updates and technical
information

The Read Me files in the “Microsoft ActiveSync” folder on your
PC or the ViewSonic Pocket PC V36 Companion CD

The latest on Windows Powered
Pocket PCs

The Microsoft Mobile Devices Web site:

www.microsoft.com/mobile/pocketpc

ViewSonic Pocket PC V36



Hardware Features

The illustrations below introduce you to the various buttons, connectors, ports,
and other features of your V36.

Front Components

T

Ref Component

Touch Screen

o=

Pocket PC

ViewSonic

Description

Selects menu commands or input text.

Program Buttons

Provides a quick way to run a specific program. By default,
they are Notes, Calendar, Contact, and Tasks buttons (left
to right).

Microphone

Receives sound and voice to record voice notes.

© 0o 06¢

Navigation Pad &
Select Button

Move up, down, left, or right in a document. The center of
the Navigation Pad functions as a Button for selecting/
activating menu choices and for taking a picture with the
built-in camera.

Speaker

Provides audio output from music and voice recordings, as
well as audible reminders and alerts.

o

Battery Charge

Glows amber when battery is being charged and turns

Indicator green when battery is fully charged.
e Notification Informs you about scheduled appointments, alarms,
Indicator reminders, and voice recording status.
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Rear Components

Ref Component

Camera Lens

Description

Lens of the integrated digital camera. See page 16 for more
information.

2]

Battery
Compartment

Compartment for the Lithium-ion battery.

Inside the battery compartment is a battery switch that can
be reset to restore your V36 to the factory default settings.

NOTE:

Always leave the battery (cold boot) switch in the ON
(right) position unless you need to return the system to
factory defaults (perform a cold boot). See page 72 for
more information. Caution: Doing this clears all data
stored in RAM.

The battery compartment cover must be in place for the
V36 to be powered on.

Reset switch

Restarts your V36.

ViewSonic Pocket PC V36



Left-Side Components

Ref Component Description

a Lanyard Eyelet Lanyard attaches to this opening.

9 Power Button Turns your V36 On or Off, or turns the backlight On or Off by
pressing and holding this button.

e Record Button Record audio (such as voice notes) by pressing and holding
this button.

Stereo Headphone | Connects stereo headphones.
Connector

ViewSonic Pocket PC V36 9



Right-Side Components

Ref Component Description

0 Battery Lock/ Locks/unlocks the battery compartment cover on the back of
Unlock Switch the V36.

10 ViewSonic Pocket PC V36



Top Components

Ref Component

IR Port

Description

Beams files to or from other mobile devices using infrared
(IR).

2]

SD/SDIO Card Slot

Accepts an optional Secure Digital card for extended
memory capacity or a ViewSonic 802.11 SDIO Card (or
other SDIO Now! compatible 802.11b card) that provides
connectivity to Wirless Local Area Networks.

Stylus Slot

Stores the stylus when it is not in use.

Bottom Components

- -

Ref Component Description

Cradle Connector

Connects the V36 to the USB synchronization cable (or to
the USB cradle --sold separately) to synchronize the V36
with your PC.

Charges the battery inside the V36 when the DC connector
of the AC adapter is attached to the cradle’s USB connector
(see the illustration on the next page).

2]

Power Connector

Connects the V36 to the AC adapter when not using the
USB cradle.
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V36 USB Cradle

The USB cradle (sold separately) provides a convenient way to charge your V36
and connect your V36 to a PC through a USB connection.

-= d"l]

Ref Component Description

USB Connector

Connects to your PC for data synchronization.

Power Connector

Connects to the DC plug of the AC adapter.

Pocket PC
Connector

Connects to your Pocket PC V36 (provides power to the V36
and charges the battery inside the V36).

Spare Battery
Connector

Charges a spare battery (see the illustration on the next
page).

© 06 0 0

Spare Battery

Indicates the charging status of a spare battery connected to

Status LED the cradle:
LED On -- battery is charging
LED Off -- battery is fully charged.
G AC adapter Connects to an AC outlet.

12
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Battery Charging Options
NOTE: The cradle is sold separately.

With the cradle

1 Slide your V36 into the cradle, or attach a spare battery to the cradle as
shown below.

2 Plug the appropriate end of the AC adapter into the power connector on
the USB.

3 Plug the other end of the AC adapter into an AC outlet, or remove the battery
from the battery compartment and connect it directly to the cradle.

L

Pochst PC x
Spare Battery

Without the cradle

Connect the DC plug from the AC adapter to the power connector on the
bottom of the V36, and plug the AC adapter into an AC outlet.

ok S

)
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NOTE: The battery-charger indicator (LED on the left) lights amber when the
battery is charging

* Allow the battery to become fully charged (about three hours). The Battery
Charge Indicator turns green when the battery is fully charged.

IMPORTANT: Whenever possible, charge the battery by connecting your V36
to an AC power source. This will keep the battery charged and prevent data loss
or damage to the battery in case the battery has been kept in a discharged
state for too long. The battery can not be over-charged.

SD Memory and SDIO Capabilities

Your V36 has an SDIO card slot which accepts an SD (Secure Digital) memory
card and SDIO Now! (Secure Digital Input/Output) compatible cards. You can
purchase an SD card to expand the memory capacity and capabilities of your

V36. Currently, you can also purchase a ViewSonic 802.11b SDIO Card. In
addition, other peripherals may be available in the future.

NOTE: Make sure your SDIO card is compatible with SDIO Now! technology,

developed by bSquare Inc.

To insert an SD memory card or SDIO card:

1 Slide the end of the card with the chipped corner into the SDIO slot (with the
label side and the V36’s front panel facing you).

2 Push the card into the slot until it clicks into place.

To remove an SD memory card or SDIO card:

e Press the card in (same direction as when inserting it). When the card pops
out slightly, you can remove it.

14 ViewSonic Pocket PC V36



E Basic Skills

This chapter introduces you to the basics of using the integrated digital camera
and working with programs and documents on your V36.

Using the Stylus

Use the stylus to navigate and select objects on the V36 touch-screen.

NOTE: You can extend the stylus to hold it more comfortably.

e Tap: Touch the screen once with the stylus to open items and select options.

e Drag: Hold the stylus on the screen and drag across the screen to select
text and images. Drag in a list to select multiple items.

e Press and hold: Press and hold the stylus on an item to see a list of actions
available for that item. On the pop-up menu that appears, tap the action you
want to perform.

[ e ;
| Pocket PC .;._..ﬂ

N

C“C")‘wj _'f“i: ®® \
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Using the Integrated Digital Camera

The V36 includes an integrated digital camera that allows you take pictures or
record short movies. The camera takes pictures with a resolution of up to 640 X
480 pixels, and previews the pictures you have taken at a resolution of 280 X

210 pixels.

Basic Camera Functions
IMPORTANT: I

| Basic Camera
: @y M2 Functions.
Ifan SD memory . \J7IX  see definitions
card is inserted ; O below.

in the V36 SDIO
O— Navigation Pad/
Select Button

slot, make sure it

is not write-
protected. If it is
write-protected,

the pictures you
take will not be
stored on the SD ™=
memory card. "™

ViewSonic

Pocket PC

Function Description / Instructions

Take Picture Allows you to take a picture. To take a picture:

D 1 Tap Start > Programs > & (VSCam icon)
2 With the Take Picture icon highlighted, either press the

Navigation Pad/Select button, or tap the Take Picture
icon.

Preview Pictures @ Allows you to preview pictures you have taken. To preview

your pictures, tap on the Preview Pictures icon.

Scrolling: To scroll through your pictures, gently tilt the
Navigation Pad right or left. Be careful not to press the
Navigation Pad/Select Button while scrolling.

Record Movie Allows you to record a short movie. To record a movie:
%\D 1 Tap Start > Programs > @ (VSCam icon)

2 To start recording your movie, highlight the Make Movie
icon by gently tilting the Navigation pad downward), then
press then Navigation Pad/Select Button or tap the
Record Movie icon.

Help Describes the functions of icons on the Settings Menu.

Provides information about camera icons and functions.

Exit Exits camera modes and returns the device to Pocket PC
i | mode.

Settings Menu Opens the Settings Menu, which lets you select various
background options for pictures you plan to take.

NOTE:

e Other Pocket PC programs are not accessible while you are using the camera
functions.

e For more detailed operating instructions, see the V36 Digital Camera User

Guide, available in PDF format on the supplied Pocket PC V36 Companion
CD.
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Today Screen

When you turn on your V36 for the first time each day (or after 4 hours of

inactivity), you will see the Today screen. On the Today screen, you can see at a
glance important information for the day.

You can also display the Today screen by tapping Eand then tapping Today.

Navigation Bar Shows Connection Status to host PC or

wireless network
Tap to switch Tap to change Volume or Mute sound
to a program. coming from speaker.

Friday, March 21, 2003

Tap to change date and time.
Tap here ko sek owner information

Tap to open an item.

&
=

Mo upcoming appaintments

Your day at a glance

Tap to create a new item.

Command Bar

ViewSonic Pocket PC V36 17



Status Icons

When the Today screen is displayed, you may see the following status icons on
the Command bar or Navigation bar. In most cases, you can tap a status icon to
display the associated control panel or more information related to the item.

For example, tap §_4 to see information about the battery status.

lcon Meaning

asp  |Active Connection: there is an active
4= |CONnection to host PC or wireless network.

aep  |INactive Connection: there is not an active
1...“ connection to host PC or wireless network.

Speaker is On.

i Speaker is Off.

Main battery is low.

Main battery is very low.

Main battery is fully charged.

Synchronization is beginning or ending.

18 ViewSonic Pocket PC V36



Navigation Bar and Command Bar

The Navigation bar is located at the top of the screen. It displays the active
program and current time, and allows you to switch programs and close

screens.
The Navigation bar and Start menu:

Shows Connection Status to host PC or
wireless network

Tap to change Volume or Mute sound.

o o< 19:05

Tap to quickly select a program
you have recently used.

@ ActiveSync
=] Calendar

|E

Tap to select a program.

Tap to see additional programs.
Tap to customize the device.

Use the Command bar at the bottom of the screen to perform tasks in
programs. The Command bar includes menu names, buttons, and the Input
Panel button. To create a new item in the current program, tap New. To see the
name of a button, press and hold the stylus on the button. Drag the stylus off
the button so that the command is not carried out.

The Command bar:

New button Input Panel button

| |
[New Edit Tooks &[] @]
T T
Buttons
Menu names

ViewSonic Pocket PC V36 19



Running Programs

Depending on the program you want to run, you can:

e Tap E or tap Start at the top of the screen and select from the menu. (You
can customize which programs you see on this menu. For information, see
section “Customizing Your V36” in Chapter 3).

o Tap ] and then tap Programs to access additional programs. Tap the icon
to run the program.

e Press program buttons on the front of your V36 to open the program. The
icons on the buttons identify the programs they are associated with. (You
can customize which programs are associated with the buttons. For
information, see the section “Customizing Your V36" in Chapter 3).

The following table contains a partial list of the program icons on your V36.

lcon Program Description
ActiveSync Synchronize information between your V36 and PC.
Calendar Keep track of your appointments and create
meeting requests.
Contacts Keep track of your friends and colleagues.
Inbox Send and receive email messages.

Pocket Internet |Browse Web and WAP (Wide Area Protocol) sites,

Explorer and download new programs and files from the
Internet.

Notes Create handwritten or typed notes, drawings, and
recordings.

Tasks Keep track of your tasks.

Pocket Excel Create new workbooks or view and edit Excel

workbooks created on your PC.

Pocket Word Create new documents or view and edit Word
documents created on your PC.

E RS0 600 S
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Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example,
you can use the pop-up menu in the contact list to quickly delete a contact,
make a copy of a contact, or send an email message to a contact. The actions
in the pop-up menus vary from program to program. To access a pop-up menu,
press and hold the stylus on the name of the item that you want to perform the
action on.

When the menu appears, lift the stylus, then tap the action you want to
perform. Or tap anywhere outside the menu to close the menu without
performing an action.

S vasks At nas D
All Tasks = Priority -
L | Send status report
] Buy birthday gift
] Call Maria
] Proof new proposal
W—-— Press and hold to display the pop-up menu.

Delete Task Using the tip of the sylus, tap the

—— action you want.
Beam Task...
—— Tap outside the menu to close it (when you
decide not select an option on the menu).

Mew Tools = -

Notifications

Your V36 reminds you in a variety of ways when you have something to do. For
example, if you have set up an appointment in Calendar, a task with a due date
in Tasks, or an alarm in Clock, you will be notified in any of the following ways:

e A message appears on the screen.
e A sound, which you can specify, is played.
e The notification LED flashes.

To choose reminder types and sounds for your V36, tap Settings on the Start
menu. On the Personal tab, tap Sounds & Notifications.
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Entering Information

You have several options for entering new information:

e Use the Input Panel to enter typed text, either by using the soft (on-screen)
keyboard or other input methods.

o Write directly on the screen.
e Draw pictures on the screen.

e Speak into the microphone to record a message. For more information on
using the microphone, see the section on “Recording a Message”.

Entering Text Using the Input Panel

Use the Input Panel to enter information in any program on your V36.

You can either type using the soft (on-screen) keyboard or write using the Block
Recognizer or Letter Recognizer. In any case, the characters appear as typed
text on the screen.

To show or hide the Input Panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your choices.

Dptions...

Block Recognizer
® Keyboard
Letter Recognirer

Transcriber

few Edit View Tools 7,

Select an input method.

Tap to see your choices.

Input Panel button

When you use the Input Panel, your V36 anticipates the word you are typing or
writing and displays it above the Input Panel. When you tap the displayed word,
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it is inserted into your text at the insertion point. The more you use your V36,
the more words it learns to anticipate.

A ¢ 335

Monthly mee a

Tap here if this is the right word.

|meeting|
123[1[2[3]a[5]6[7[a]9[0]-[=[«
Ta[alwle v t[y[uli]o]p|I
capla[s[d[f[aln[jlk[1[;]"
shiftfz[x [c[v[b[n[m],[. ]/
crfai] " [\ ] [+]1]
Wew Edit Tools E

Pl

(—|—)

g

NOTE: To change word suggestion options, such as the number of words
suggested at one time, tap Setting on the Start menu. On the Personal tab,
tap Input, then tap the Word Completion tab.

Block Recognizer
With Block Recognizer, you can use the stylus to input characters and words.

To type with Block Recognizer:

1 Tap the arrow next to the Input Panel button, and then tap Block
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Block Recognizer, open Block
Recognizer, and then tap the question mark (?) next to the writing area.

Soft Keyboard

The Soft Keyboard is an on-screen keyboard displayed at the bottom of the
screen.

To type with the soft keyboard:

1 Tap the arrow next to the Input Panel button, and then tap Keyboard.
2 On the keyboard that is displayed, tap the keys with your stylus.
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Letter Recognizer

With Letter Recognizer, you can write letters using the stylus just as you would
use a pen on paper.

To type with Letter Recognizer:

1 Tap the arrow next to the Input Panel button, and then tap Letter
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Letter Recognizer, open Letter
Recognizer and then tap the question mark next to the writing area.

Transcriber

With Transcriber you can write anywhere on the screen using the stylus just as
you would on paper. Unlike Letter Recognizer and Block Recognizer, you can
write a sentence or more of information; then, you pause and let Transcriber
change the written characters to typed characters.

To type with Transcriber:
1 Tap the arrow next to the Input Panel button, and then tap Transcriber.
2 Write anywhere on the screen.

For specific instructions on using Transcriber, open Transcriber and then tap the
question mark in the lower-right corner of the screen.
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Writing on the Screen

In any program that accepts writing—such as the Notes program and the
Notes tab in Calendar, Contacts, and Tasks—you can use your stylus to write
directly on the screen. Write the way you do on paper. You can edit and format
what you have written and convert the information to text later.

To write on the screen, tap the Pen button to switch from tapping to writing
mode. This action displays lines on the screen to help you write.

£iF |motes i dfaa @

Bring The |
Pocke7r PC
V3IG! |

=
New Edit Tools @@ 8

l—Tap the Pen button and use
your stylus like a pen.

Some programs that accept writing may not have the Pen button. See the
documentation for that program to find out how to switch to writing mode.

If you want to edit or format writing, you must select it first.
To select writing:

1 Press and hold the stylus next to the text you want to select until the
insertion point appears.

2 Without lifting, drag the stylus across the text you want to select.
If you write accidentally on the screen, tap Tools, then Undo, and try again.

You can also select text by tapping the Pen button to deselect it and then
dragging the stylus across the screen.
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You can cut, copy, and paste written text in the same way you work with typed
text: press and hold the stylus on the selected words and then tap an editing
command on the pop-up menu, or tap the command on the Edit menu.

To convert writing to text, tap Recognize on the Tools menu.

If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or press and hold the selected words and then
tap Recognize on the pop-up menu). If a word is not recognized, it is left as
writing.

F17 | motes A T T £ [motes o oWiaan @
£y

Briﬂg The
Pocker $C Pocker £C

Briﬂg The W

Tt

iy

e

Becognise |

Alwrnate | - -

Mew Edit Tools ] Edit Tools E =)-
| Select the text you want to Your handwriting is
convert and tap Recognize turned into text.

on the Pop-up menu.
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing. To do so, press and hold the
incorrect word (tap one word at a time). On the pop-up menu, tap Alternates.

A menu with a list of alternate words appears. Tap the word you want to use, or
tap the writing at the top of the menu to return to the original writing.

Tap the word you want
to use.

— Or, tap outside the
pop-up window to return
to your original writing.

olu|i [I———[w w|#t
|h=- Edit Tools (6| | =-

Some tips for getting good recognition are listed below:

e Write on the lines and draw descenders below the line. Write the cross of the
“t” and apostrophes below the top line so that they are not confused with
the word above. Write periods and commas above the line.

For better recognition, use the Tools menu to increase the zoom level to 300%.

o Write the letters of a word close together and leave big gaps between words.

e Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.

e If you add writing to a word to change it (such as changing a “3” to an “8")
after you attempt to recognize the word, the writing you add will not be
included if you attempt to recognize the writing again.
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Drawing on the Screen

You can draw on the screen in the same way that you write on the screen. The
difference between writing and drawing on the screen is how you select items
and how they can be edited. For example, selected drawings can be resized,
while writing cannot.

To create a drawing, cross three ruled lines on your first stroke. A drawing box
appears. Drawings that do not cross three ruled lines will be treated as writing.

£iF |motes “dfan @

L el al P
I I =
I I
I I
| e = il |
} e ol } =
I I The drawing box indicates the
I I boundaries of the drawing.
T I L
I I
I I
I I
. 1z
| I
I I
I - I
I I
[ \\/ [
[ S -
New Edit Tools ([ | =18

You may want to change the zoom level so that you can more easily work on or
view your drawing. Tap Tools, then choose a zoom level.

If you want to edit or format a drawing, you must select it first.

To select a drawing, press and hold the stylus on the drawing until the selection
handle appears. To select multiple drawings, deselect the Pen button and then
drag to select the drawings you want.

You can cut, copy, and paste selected drawings by pressing and holding the
selected drawing and then tapping an editing command on the pop-up menu, or
by tapping the command on the Edit menu. To resize a drawing, make sure the
Pen button is not selected, and then drag a selection handle.
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Recording a Message

In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording in the
Notes tab. In the Notes program, you can either create a stand-alone
recording or include a recording in a written note. If you want to include the
recording in a note, open the note first. In the Inbox program, you can add a
recording to an email message.

To create a recording:

1 Hold the V36’s microphone about three inches from your mouth.

2 Press and hold the record button on the left side of the unit. If the speaker is
not muted, a beep indicates that your V36 is recording. The notification LED
at the top of the unit glows red while recording is in progress.

3 While holding down the record button, speak into the microphone.

4 To stop recording, release the record button. Two beeps will sound. The new
recording appears in the note list or as an embedded icon.

NOTE: You can also make a recording by tapping the Record button on the

Recording toolbar.

To play a recording:

e Tap itin the list or tap its icon in the note.

£ notes % df e @
F e il = Indicates an embedded
I recording.

Business
Proposal

Tap to begin recording.

Lll] b [F5=-]44 " I-ﬂ-
AN

! Tap to show or hide the
Recording toolbar.

ViewSonic Pocket PC V36 29



Recording Formats

Your V36 supports several formats for voice notes. The formats vary in both the
quality of the recording and the size of the sound file. When selecting a
recording format, you should consider the quality you need as well as how
much storage memory the recording will use on your V36.

Not all recording formats are compatible with other software or computers. If
you will share your recordings with others or transfer a recording to your PC, be
sure to choose a recording format that is supported by the software used to
play recordings on the other computer.

To select a recording format:

1 On the Start menu, tap Settings, and then tap the Input icon.

2 On the Options tab in the Input control panel, select a voice recording
format from the drop-down list.

The list of recording formats on your V36 indicates the sample rate, whether
the format is stereo or mono, and how much storage memory is required per
second of recording. You may need to experiment with different sample rates
and formats to determine which format best suits your voice.

Using My Text

When using Inbox, use My Text to quickly insert preset or frequently used
messages into the text entry area. To insert a message, tap My Text, and then
tap a message.

NOTE: After inserting a My Text message, you can add text to it before you
send the message.

To edit a My Text message, on the Tools menu, tap Edit My Text Messages.
Select the message you wish to edit and make desired changes.
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B Managing Your V36

This chapter tells you how to effectively manage power and memory, and how
to add/remove programs and back up your data.

Managing Power

It is important to maintain a continuous power supply to the V36 to prevent
data or files stored in RAM from being damaged. Your V36 can operate either on
external AC power or internal battery power. Note that you will lose any
information, programs or settings that you have added if the battery completely
runs out of power.

A fully charged battery should provide power for up to 9 hours of use with the
backlight turned Off. The operating time of a fully charged battery depends on
how you are using the V36. Using some functions, such as some of the
multimedia features or a Secure Digital card, may consume extra battery
power.

You should recharge the battery when a warning of low power is displayed on
your V36, or the V36 will turn off automatically. You will need to connect the
V36 to external AC power for charging before you can use it again.

See Chapter 1 for information about powering on your V36.
To check the remaining power:

1 On the Start menu, tap Settings.

2 On the System tab, tap the Power icon.

The remaining power is displayed on a status bar in the Power control panel.

Power-Saving Tips
Follow these suggestions to maximize the battery’s operating time:

e Turn off the backlight. Press and hold the power button to turn off the
backlight, or use the Backlight control panel to set the backlight to turn off
automatically after a short period of inactivity.
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* Suspend frequently. Use the Power control panel to shorten the length of
continuous idle time before your V36 auto-suspends. Press the power button
to turn off your V36 when it is not in use, even for a short time.

* Always use AC power when connecting your V36 to your PC. Note
that your V36 will not auto-suspend while it is connected.

* Turn off sounds. Use the Sounds & Notifications control panel to turn off all
but the most necessary system sounds.

e Avoid using SD memory/SDIO card accessories while on battery
power. Some SD memory/SDIO cards use considerable power and will
quickly drain your battery.

* Do not “listen” for infrared transfers. Although you can set your Pocket
PC to constantly monitor the IR port for files sent from other devices, doing
so will quickly drain your batteries.

Managing Memory

Your V36 uses two kinds of memory: storage and program memory (RAM), and
optional memory cards.

Storage and Program Memory

RAM (Random Access Memory) on your V36 is shared between storage memory
and program memory. “Storage memory” is used to store the data you create
and additional programs you install. “Program memory” is used to run
programs on your V36. Your V36 automatically manages the allocation between
storage and program memory. However, in some situations, such as when the
memory is running out, your V36 may not be able to automatically adjust the
allocation.

Memory Cards

Memory cards are small, removable flash storage cards that enable you to
expand the memory of your V36. You can use memory cards for backup
storage, archives, or to transfer large files to other devices. Your V36 supports
Secure Digital memory cards. Memory cards can be purchased from a variety of
third-party vendors.

SDRAM Memory Allocation

The V36 has 64 MB of SDRAM memory:

e 7 MB is used to boot the device.
e The remaining 57 MB of memory is available for user applications and file
storage.
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Finding and Organizing Information

The Find feature on your V36 helps you quickly locate information.

To find a file, on the Start menu, tap Find. Enter the text you want to find,
select a data type, and then tap Go to start the search.

NOTE: To quickly find information that is taking up storage space on your V36,
select Larger than 64KB under Type.

You can also use the File Explorer to find files on your V36 and to organize
these files into folders. On the Start menu, tap Programs, and then tap File
Explorer.

Tap to change folders.

[ My Device ~ Mame ~ —— Select the sort order for the list.
L3 CannMar Tap the folder name to open it.
™My Documents

] My Flash Disk

i Program Files

%] Storage Card View All Fias

) Temp

) Utility :*“E -

. aste Shortout

W doves Mew Folder Press and hold to create a new folder.
edit op...[~[0]M 2 =8
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Customizing Your V36

You can customize the settings of the V36 to your own preferences.

Tap Start, then tap Settings. You can tap any of the icons on the Personal,
System, or Connections tabs to customize your V36. The customization
options are as follows:

Options Description

PERSONAL |Buttons Assigns your favorite programs to the program buttons,
and sets the repeat rate of the scroll dial.

Input Sets the settings related to Block Recognizer, soft
keyboard, Letter Recognizer and Transcriber input
methods.

Menus Selects the items that appear on the Start menu and the

New menu on the Today screen.

Owner Saves your personal information.
Information

Password Sets the password to your V36 to protect the stored
data.

Sounds & Sets the conditions and types of the sounds, system

Notifications volume, and ways of notifications.

Today Sets the items that appear on the Today screen.

SYSTEM About Shows information about the version of the operating

system, the name of the Pocket PC, and copyrights.

Backlight Adjusts the backlight of the display.

Clock Sets the current time and alarm.

Memory Adjusts the allocation of data and program storage.

Power Shows the remaining battery and external AC power, and

set the time for the V36 to turn off automatically.

Regional Sets the region of your location, and formats for number,
Settings currency, time and date.

Remove Removes programs pre-installed in RAM.

Programs

Screen Realigns the touch screen for accurate taps.
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Setting a Password

A password can safeguard your V36 against unauthorized use. To set your
password:

1 Tap Start, tap Settings, then tap the Password icon on the Password tab.

2 Tap the digits or characters to set your password. You can set a four-digit
password, or a long password containing a combination of at least seven
characters, digits or punctuation.

3 You can set the time for the V36 to prompt for a password after idling.

4 Tap OK.

Adding or Removing Programs
Adding Programs

You can add even more functionality to your V36 by installing additional
software and programs. A wide variety of software is available for Windows
Powered Pocket PCs, ranging from custom business applications and system
utilities to games and entertainment. Some programs are available from
software vendors or on the Web.

Install only programs designed specifically to run on a Pocket PC personal
digital assistant and/or a Windows Powered Pocket PC. You cannot run
programs designed for Windows on your V36. In addition, you may need a
version of the program designed specifically for the X-Scale processor used by
your V36.

Install software to your V36 by first loading the installation files onto your PC.
Use ActiveSync on your PC to transfer and install programs to the storage
memory (RAM) in your V36.

Removing Programs

To free storage memory on your V36, you can remove programs you no longer
use. Only programs that are stored in RAM can be removed.

Programs pre-installed in Flash ROM cannot be removed; however, these
programs do not use storage memory.

To remove a program:

1 On the Start menu, tap Settings.

2 On the System tab, tap Remove Programs.

3 Select the program in the list, and then tap Remove.

NOTE: If the program does not appear in the list of installed programs, use
File Explorer on your V36. Locate the program, press and hold the stylus on
the program, and then tap Delete on the pop-up menu.
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Backing Up Data

To prevent loss of data, you should back up your V36 frequently. Your V36
comes with two programs for backing up data:

* Microsoft ActiveSync. ActiveSync enables you to back up data to your PC.
You can back up all data on your V36, or only your PIM databases (Calendar,
Contacts, and Tasks). You can set ActiveSync to back up automatically each
time you connect, or you can back up manually, whenever you choose. For
more information, see ActiveSync Help on your PC.

 Backup. Backup enables you to back up all data stored in the internal
(RAM) memory on your V36. You can save the backup file on an optional
Secure Digital memory card.

Using Backup
Backup allows you to back up data that is stored in RAM while your V36 is
powered on.

NOTE: An SD memory card is required to back up your data.

Backing up data using Backup
1 Close all running applications and insert a memory card.

2 Disconnect your V36 from your PC.

3 On the Start menu on your V36, tap Programs and then tap the Backup
icon.

4 Tap Backup, then tap Next.

5 Tap your preference of storage media for backing up your data, then tap
Next.

6 Tap the item you want to back up, then tap Next.
7 Tap Backup, then tap Yes to start the backup process.

8 Remove the memory card after the backup is complete.

CAUTION:

o Never delete the backup file in the memory card. If the backup file is
deleted, the backup data will be lost and cannot be restored.

e When you use the backup file to restore information, information on
your V36 is replaced with the information stored in the backup file.
If you have created files on your V36 since the last backup and do
not want to delete these files during the restore process, move the
files from your V36 to your PC--or to an optional memory card--
before restoring the information.

Restoring data using Backup

1 Close all running applications and insert a memory card with the backup
data.
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Disconnect your V36 from your PC.
On the Start menu tap Programs, then tap the Backup icon.

Tap Restore, then tap Yes.

Tap the item you want to restore, then tap Next.

2
3
4
5 Tap your preference of storage media for restoring your data, then tap Next.
6
7 Tap Restore, then tap Yes to start the restore process.

8

Remove the memory card after the restore process is complete, and reset
your V36.

IMPORTANT: When you restore data, your V36 must have the same regional
settings that it had when you completed the backup; otherwise, you will not be
able to restore the files. To change regional settings, on the Start menu, tap
Settings, and then tap the Regional Settings icon on the System tab. Select
your region from the drop-down list.
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n Microsoft ActiveSync

This chapter tells you what the Microsoft ActiveSync program is and what you
need to do to use it.

Using Microsoft ActiveSync

NOTE: ActiveSync is already installed on your V36. You need to install
ActiveSync on your PC. (For information on installing ActiveSync, see Step 5 of
the Quick Start procedure in Chapter 1, “Installing Microsoft ActiveSync.”)

Microsoft ActiveSync allows you to synchronize the information on your PC with
information on your V36. Synchronization compares the data on the two sides
and updates both computers with the most recent information. For example,
you can:

e Keep your Pocket Outlook Contacts, Calendar, and Tasks databases up-to
date by synchronizing your V36 with Microsoft Outlook data on your PC.

IMPORTANT: Outlook must be installed on your PC in order to synchronize
your email data.

e Synchronize email messages in your V36 Inbox with email messages in
Microsoft Outlook on your PC.

e Synchronize Microsoft Word and Microsoft Excel files between your V36 and
PC. Your files will be automatically converted to the correct format.

With ActiveSync, you can also:

e Back up and restore your V36 data.
e Copy (rather than synchronize) files between your V36 and PC.
e Add and remove programs on your V36.
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Synchronizing Data

Once you have created a synchronization partnership and completed the first
synchronization, you can initiate synchronization from your V36. Follow this
procedure:

1 Connect your V36 to your PC. (See “Connecting Your PC” in Chapter 1.)

2 On your V36, tap ], and then tap ActiveSync.

3 Tap &3 to begin synchronization.

{j‘ ActiveSync ot ofZ B:50 9

@
Connected View connection status.

Tap to connect and synchronize.
‘ ; Tap to stop sycnchronization.

@ Sync Ie Stop

Synchronize with Windows PC . -
Last Sync: S/14/03 6:50 PM — View synchronization status.

Tools E|*

Tap to change Volume or Mute all sounds.

By default, ActiveSync does not automatically synchronize all types of
information. Use ActiveSync options to turn synchronization on and off for
specific information types. You can:

e Control when synchronization occurs by selecting a synchronization mode.
For example, you can synchronize continually while the V36 is connected or
only when you choose the synchronize command.

e Select which information types are synchronized and control how much data
is synchronized. For example, you can choose how many weeks of past
appointments you want synchronized.

For information on setting ActiveSync options and using ActiveSync on your PC,
see ActiveSync Help on the PC. For information on using ActiveSync in your
V36, see ActiveSync Help on the V36.
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Connecting to Your PC

CAUTION: Do not shut down or restart your PC while your V36 is
connected. Turn off your V36 or disconnect the USB cable before you
shut down your PC.

Connecting by USB Cable

CAUTION: Before you connect your V36 to the USB synchronization
cable, be sure of the following: your PC is on, you have installed
ActiveSync on your PC, and ActiveSync is configured to allow a USB
connection.

For connection instructions, see Installing Microsoft ActiveSync in Chapter 1.

Connecting by Infrared

You can use the IR port to synchronize data with your PC, in place of using the
cable.

IR ports can be found on many notebook computers; however, on a PC, you
may need to install and configure an IR port. To install the port, follow the
manufacturer’s instructions.

For complete instructions on connecting to your PC by infrared, refer to
ActiveSync Help on your PC.
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E Pocket Outlook

This chapter introduces you to the basics of Microsoft Pocket Outlook, including
Calendar, Contacts, Tasks, Notes and Inbox.

Scheduling Appointments/Meetings

Use Calendar to schedule appointments, including meetings and other events.

You can check your appointments in one of several views (Agenda, Day, Week,
Month, and Year) and easily switch views by using the View menu.

15? Calendar o W& 725 9
Augo6,00 BMTWTFS G35
Waorking at home
Lunch w/ Adam Tap to display or edit the
12 Op (Cormer Cafe) appointment details.

| __Tap to go to Today.

Status Meeting
EH TG HIE

NewToos[ ] JEED B

—Tap to create a new appointment.

NOTE: You can customize the Calendar display (for example, change the first
day of the week), by tapping Options on the Tools menu.
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Creating an Appointment

1 In Day or Week view, tap the desired date and time for the appointment.

2 Tap New.

AppaankrmEnt

Subject:

Locatson:
Stasts:
Ends:
Type:
Choours!
Raminder:

Cateqories:

Tap to return to the calendar (the
appointment is saved automatically).

J' Tap to choose from predefined text.

*1— Tap to choose from previously

12:00 P
1:00 P

8/6,/00
8/6,00

entered locations.

*1— Tap to select a time.

I
once
Remind ma

15 minute(s)
MO categores.,

Tap to select a date.

w231]2]3

4[sle[7[aa[n]-

Notes is a good place for
maps and directions.

T.gq'ﬂl?ftlr?l.llj
caplals[d[f[aln]ile[1]:]

shift| z[#[c{vib|n[m]

culan] " T\ ]

Edit

description and a location.

all available fields.

When using the Input panel, tap first to select the field, and then enter a

If needed, tap the date and time to change them.

Enter other desired information. You will need to hide the Input panel to see

To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing

Thoughts and Ideas” later in this chapter.

7

NOTE: If you select Remind me in an appointment, your V36 will remind you

Tap OK to return to Calendar.

according to the options set in the Sounds & Notifications control panel.
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Using the Summary Screen

When you tap an appointment in Calendar, a summary screen displays. To
change the appointment, tap Edit.

Lunch w/ Adam by

View appointment details.
12:00p-1:00p Sun, Bf6/2000 —

Corner Cafe

View.
Ramamber portfolio —_—

[Edit Tools =18
4
| Tap to change appointment.

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting notice will be created automatically and sent either when
you synchronize Inbox or when you connect to your email server. Indicate how
you want meeting requests sent by tapping Tools and then Options. If you
send and receive email messages through ActiveSync, select ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 1In the appointment details, hide the Input panel, and then tap Attendees.
3 From the list of email addresses in Contacts, select the meeting attendees.
The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar
Help and Inbox Help on your V36.
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Managing Contacts

Contacts maintains a list of your friends and colleagues so that you can easily
find the information you are looking for, whether you are at home or on the
road. Using the IR port on the V36, you can quickly share Contacts information
with users of Pocket PCs and other mobile devices.

Select the category of contacts you
want to display in the list.

Tap and enter part of a name
to quickly find it in the list.

Tap to see additional phone

Barr, Adam (206) 555-1212 w —/— ¢
Bready, Richard ic e o numbers and e-mail addresses.
T CCORTITROR. | Tap to display or edit the
Create Copy contact details.
Delete Contact Press and hold to display a

pop-up menu of actions.
Send E-mail bo Contack...

Beam Contact..

v View Tools ﬂ|-

TLp to create a new record.

NOTE: To change the way information is displayed in the list, tap Tools then
tap Options.
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1 Tap New.

—

Tap to return to the conta
list (the contact is saved
automatically).

¥

ERIE T

Crepartment:

Compay:
Work tal:
‘Whork Fa:
‘Work adidr: -
E-mal
Mobds tal:
Detals | Notes Notes is a good place for
1231]2[3]4[s[6[7]8]a]0]-]= maps and directions.
Tab[a[wle[r[t]yluli [n|p

h
S}HI'HEXI:JT nrn, J"—'

cufai]* T\] Lt[]=
i =R

2 Using the Input panel, enter a name and other contact information. You will
need to scroll down to see all available fields.

- Scroll to see more fields.

3 To assign the contact to a category, scroll to and tap Categories then select
a category from the list. In the contact list, you can display contacts by
category.

4 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” later in this chapter.

5 Tap OK to return to the contact list.

Finding a Contact

There are four ways to find a contact:

e On the Start menu, tap Find, enter the contact name, select Contacts for
the type, and then tap Go.

e In the contact list, enter a contact name in the box under the Navigation bar.

To show all contacts again, clear text from the box or tap the button to the right
of the box.

e In the contact list, tap the category list (labeled All Contacts by default)
then select the type of contact that you want displayed. To show all contacts
again, select All Contacts. To view a contact not assigned to a category,
select None.
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* To view the names of companies your contacts work for, in the contact list,
tap View then tap By Company. The number of contacts that work for that
company will be displayed to the right of the company name.

Using the Summary Screen

When you tap a contact in the contact list, a summary screen displays. To
change the contact information, tap Edit.

Adam Gabor ] .
—+——View contact details.
Programmer

RED
Inspired Technologies

(206) 955-1212 Wk tel
111 First St. ‘idark sddr

SuETmArY | Hotas E
e Tok &

Tap to view notes.

|— Tap to change contact information.
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Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do.

Select the category of tasks you want to
display in the list.

X
Tasks Priority =1 Select the sort order of the list.
g L TEOTS ! Indicates high priority.
[] Buy birthday gift
] call Maria
] Proof new proposal
—— Tap to display or edit the task details.
Create Copy
Delete Task Press and hold to display a
_—_ pop-up menu of actions.
Beam Task...
A Tools B«

Tap to create a new task.
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Creating a Task
1 Tap New.

Tap to return to the task list
(the task is saved automatically).

7| Tasks i dEmi0 (@D

Subact | =H— Tap to choose from
Priorky: Normal predefined subjects.
Status: NoOt Completad
Starts: NOne
Due; None
Coows: Once
Rerraricher

Categories: NO Cateqories...
Tarsk | m! Notes is a good place for

i[1[2[3[4]s]e[7[a]o[o]-[=]w maps and drawings.
[ritiylulifojp|L]]
!

Tabja|w]e
CAP|a |s|d
Shift[ # [% | cfv| ol 14
cifai] - [\ [4]t]«]>
Edit

2 Using the Input panel, enter a description.

3 You can enter a start date and due date, or enter other information by first
tapping the field. If the Input panel is open, you will need to hide it to see all
available fields.

4 To assign the task to a category, tap Categories then select a category from
the list. In the task list, you can display tasks by category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” later in this chapter.

6 Tap OK to return to the task list.
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Using the Summary Screen

When you tap a task in the task list, a summary screen displays. To change the
task, tap Edit.

| rasks o dca0a @
Send status report !
—4— View task details.
bart B/18/2000
— a/18f 2| Tap to show or hide additional
Send o the whole team using the new summary information.
format,
—t— " \/iew notes.
Edit Tools =-

[— Tap to change task.
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Notes: Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is already open when you create the recording, it
will be included in the note as an icon. If the note list is displayed, the recording
will be created as a stand-alone recording.

& Tap to change the sort order of the list.

Tap to change open a note or play a recording.

| Press and hold to display a pop-up
menu of actions.

rIE TTF =T [ [ Tap to record.
Pntele] S

. Tap to show or hide the Recording toolbar.

Tap to create a new item.

Creating a Note

1 Tap New.

2 Create your note by writing, drawing, typing, or recording. For more
information about using the Input panel, writing and drawing on the screen,
and creating recordings, see “Entering Information” in Chapter 2.
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Inbox: Sending and Receiving Email

Use the Inbox to send and receive e-mail messages with Microsoft Outlook on
your PC.

Synchronizing Email Messages

Email messages can be synchronized as part of the general synchronization
process. To do this, you need to enable Inbox synchronization in ActiveSync.
For information on enabling Inbox synchronization, see ActiveSync Help on
the PC.

During synchronization:

e Messages are copied from the mail folders of Exchange or Outlook on your
PC to the ActiveSync folder in Inbox on your V36.

e Email messages in the Outbox folder on your V36 are transferred to
Exchange or Qutlook, and then sent from those programs.

e Email messages in subfolders must be selected in ActiveSync on your PC in
order to be transferred.

Using the Message List

Messages you receive are displayed in the message list. By default, the most
recently received messages are displayed first in the list.

Select the Internet Service Provider and
the folder you want to display.

& Fobert Brown
RE: Tesday™s Fheeting

5 My Ak Mark as Unread

3 .

e : - Press and hold to display a pop-

.‘" Status Repol up menu of actions.

iy Bracdey Bach

S o e | Rely

G Suwt Hursl  Reply AR

| PodetPC Forward

=] Liruchs Mol _—
Rt Dirlete

s e 1 - E -

= e wirkre Lot

(5 Secbam, Barr 7™ v |
Cion't Forget -

Iridscce: ActivaSyrss 11 Tber,

tew Tooks Services [ 4 @[

Tap to open a message.

Tap to connect, and to send and receive e-mail.

Ta'p to connect to the selected Internet
Service Provider.
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When you receive a message, tap it to open it. Unread messages are displayed
in bold.

M - Tap to return to the message list.

From: Robsert Brown
Subject: RE: Todyy's Meeting
Sent: 4124001 84547 AM

Jut & reminder 1o bring your indidual
sehach e for th st 2 guartiens with
oL, We will be dscussing progects and
timeknes.

Tharics,
Boby

| Tap to delete this message.
New Edt (3 F @ @ =-

-

Tap to view the previous or next message.

Tap to reply to or forward this message.

IMPORTANT: When you synchronize with your PC, by default, you will receive
messages from the last three days only, the first 100 lines of each new
message, and file attachments of less than 100 KB in size. The original
messages remain on your PC.
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To compose a message, do the following:

1 Tap New.

2 In the To field, enter an email of one or more recipients, separating them
with a semicolon, or select a name from the contact list by tapping the
Address Book button. All email addresses entered in the email fields in
Contacts appear in the Address Book.

Tap to send the message.

Pt <. #1— Tap to show or hide the complete header.

Mew Edt My Tent 7] (1 =8
Tap to show or hide the recording toolbar.

Tap to display the Address Book.
Tap to insert common (frequently used) messages.

3 Compose your message. To enter preset or frequently used messages, tap
My Text and select a message.

4 Tap Send when you have finished the message. If you are working offline,
the message is moved to the Outbox folder and is sent the next time you
connect. The message is placed in the Outbox folder on your device.

Managing Email Messages and Folders

By default, messages are displayed in one of five folders for each service you
have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. The
Deleted Items folder contains messages that were deleted from the V36.

The behavior of the Deleted and Sent Items folders depends on the options you
have chosen. In the message list, tap Tools then tap Options. On the
Message tab, select your options.

If you want to organize messages into additional sub-folders, tap Tools, then
tap Manage Folders to create new folders. To move a message to another
folder, in the message list, press and hold the message then tap Move on the
pop-up menu.
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E Companion Programs

This chapter tells you about Microsoft Pocket Word and Microsoft Pocket Excel.

Pocket Word

Microsoft Pocket Word works with Microsoft Word on your PC to give you easy
access to copies of your documents. You can create new documents on your
V36 or you can copy documents from your PC.

IMPORTANT: Synchronize documents between your PC and your V36 regularly
so that you have the most up-to-date content in both locations.

Using Pocket Word

1 On the Start, tap Programs and then tap the Pocket Word icon.

2 Type the name of a document in the file list or tap New to open a blank
document.

NOTE: To open a template rather than a blank document, select a template for
new documents. Tap on the Tools menu, tap Options, then browse to select
the default template. When you tap New, the template appears with
appropriate text and formatting already provided.

You can open only one document at a time; when you open a second document,
you will be asked to save the first. You can save a document you create or edit
in a variety of formats, including Pocket Word (.psw), Rich Text Format (.rtf),
and Plain Text (.txt).

You can enter information in Pocket Word in four modes: writing, drawing,
typing, and recording. Use the View menu to switch between modes. Each
mode has its own toolbar which you can show or hide by tapping the Show/
Hide Toolbar button on the Command bar.

e Typing Mode. Use the Input panel to enter typed text into the document
with the soft keyboard. For more information on entering typed text, see
“Entering Information” in Chapter 2.

e Writing Mode. In writing mode, use your stylus to write directly on the
screen. Ruled lines are displayed as a guide, and the zoom magnification is
greater than in typing mode to allow you to write more easily. For more
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information on writing and selecting writing, see “"Entering Information” in
Chapter 2.

NOTE: Written words are converted to graphics (metafiles) when a Pocket
Word document is converted to a Word document on your PC.

e Drawing mode. In drawing mode, use your stylus to draw on the screen.
Gridlines appear as a guide. When you lift your stylus off the screen after
the first stroke, you will see a drawing box indicating the boundaries of the
drawing. Every subsequent stroke within or touching the drawing box
becomes part of the drawing. For more information on drawing and selecting
drawings, see “Entering Information” in Chapter 2.

» Recording mode. Use recording mode to embed a recording into your
document. Recordings are saved as WAV files. For more information on
recording, see “Entering Information” in Chapter 2.

Tips for Working in Pocket Word

e You can change the zoom magnification by tapping View and then taping
Zoom. Then select the percentage you want. Select a higher percentage to
enter text and a lower one to see more of your document.

e If you are opening a Word document created on a PC, select Wrap to
Window on the View menu so that you can see the entire document.

Pocket Excel

Microsoft Pocket Excel works with Microsoft Excel on your PC to give you easy
access to copies of your workbooks. You can create new workbooks in your
V36, or you can copy workbooks from your PC to your V36. Synchronize
workbooks between your PC and your V36 so that you have the most up-to-
date content in both locations. Pocket Excel provides fundamental spreadsheet
tools, such as formulas, functions, sorting, and filtering, which enable you to
create simple workbooks, such as expense reports and mileage logs.

1 On the Start menu, tap Programs and then tap the Pocket Excel icon.

2 Tap the name of a workbook in the file list or tap New to open a blank
workbook.

You can open only one workbook at a time; when you open a second workbook,
you will be asked to save the first. You can save a workbook you have created
or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Tips for Working in Pocket Excel
e View in full-screen mode to see as much of your worksheet as possible. Tap
View and then tap Full Screen. To exit full-screen mode, tap Restore.

o If your workbook contains sensitive information, you can protect it with a
password. To do so, open the workbook, tap Edit, and then tap Password.

e Show or hide window elements. Tap View then tap the elements you want
to show or hide.
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Freeze panes on a worksheet. First, select the cell where you want to freeze
panes. Tap View and then tap Freeze Panes. You might want to freeze the
top and furthest left panes in a worksheet to keep row and column labels
visible as you scroll through a sheet.

Split panes to view different areas of a large worksheet. Tap View and then
tap Split. Then drag the split bar to where you want it. To remove the split,
tap View and then tap Remove Split.

Show and hide rows and columns. To hide a row or column, select a cell in
the row or column you want to hide, tap Format, tap Column, then tap
Hide. To show a hidden row or column, tap Tools, tap Go To then type a
reference that is in the hidden row or column. Tap Format, then tap Row or
Column, then tap Unhide.

Windows Media Player for Pocket PC

Use Microsoft Windows Media Player for V36 to play digital audio and video files
that are stored on your V36 or on a network. To switch to Windows Media

Player for V36, tap B and tap Windows Media.

Tap to display the WindowsMedia.com
website.
E Wirnbuws Media &

" | "7 Windnuws Mndin - B4 Fops

Tap to adjust the playback progress
of a selected file.

u_ —
> P (§ —=0=

Tap to adjust volume.

Tap to mute (temporarily silence) the audio.
Tap to skip to the next file.

Tap to play a previous file.

Tap to stop.
Tap to play or pause.

Use Microsoft Windows Media Player on your PC to copy digital audio and video
files to your V36. You can play Windows Media and MP3 files on your V36.

For more information about using Windows Media Player, tap F_}']then tap Help.
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Microsoft Reader

Use Microsoft Reader to read eBooks on your V36. Download books to your PC
from your favorite eBook Web site. Use ActiveSync to copy the book files to
your activated V36. The books appear in the Reader Library, where you can tap
them in the list to open them.

NOTE: Before you can use Microsoft Reader, you must activate it from the
Microsoft activation site (http://das.microsoft.com/activate). Follow the
directions given at the Microsoft site.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:

e Page through the book by using the scroll dial on your V36 or by tapping the
page number on each page.

* Annotate the book with highlighting, bookmarks, notes, and drawings.
e Search for text or look up definitions for words.

The Guidebook contains all the information you need to use the software. To
open the Guidebook, tap Help on the Reader command bar. Or, on a book
page, press and hold on the book title, and then tap Help on the pop-up menu.

To switch to Microsoft Reader, taprj’-i, tap Programs then tap Microsoft
Reader.

Getting Books onto Your V36

You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary are also included in the MSReader folder on the
Companion CD.

Use ActiveSync to download the files from your PC to your activated V36 as
described in the Read Me file in the MSReader folder.
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Using the Library

The Library is your Reader home page. The home page displays a list of all
books stored on your V36 or storage card.

To open the Library:

e On the Reader command bar, tap Library.
e On a book page, tap the book title, and tap Library, on the pop-up menu.
To open a book, tap its title in the Library list.

Tap to scroll

Library = through the
Library list.

Tap to select
a sort order.

The Best Amernican Short Stories
The Ghost Writer
. Tap to open a

The Hundred Secret Senses =1
book.

Tap to specify the
books you want to
display in the list.

Outiander

Suger Plum Dead
Ancther Warld

Winter of the Wolf Moon
The Last Precinct

On Writing

S Gl Fazage to Juneau

Tap here to navigate -
to other parts of the - Help Cf Love and Other Demons

Reader.
Stranger in a Strange Land
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Reading a Book

Each book consists of a cover page, an optional table of contents, and the
pages of the book. Navigation options are listed in the bottom portion of the
cover page.

The first time you open a book, you will probably want to go to the first page or
to the table of contents, if there is one. Subsequently, whenever you open the
book, you automatically go to the last page read.

In addition to the text, each book page includes a page humber and book title.

——t— The Call of the Wild

Tap to select a
navigation option

were booming the find, thousands
of men ﬁ Tushing _into_the |
Morthland. Th{ Add Bookmark +— Drag to select text
dogs, and the | . .4 Highlight and then tap an
were heavy o | option.

Add Note

muscles by whig =
coats to prote Add Drawing

frost. Find...
Buck lived | Copy Text
the sun-kissed : 7

It stood back from the road, half
hidden among the trees, through
which glimpses could be caught
of the wide cool veranda that ran

Tap arrows to turn
the page, or press
and hold page # to
bring up page title.

15—

You can also page through a book by using the scroll dial on your V36.

Using Reader Features

Reading a book electronically gives you several options not available with paper
books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the
pop-up menu, as described here.

e Search for Text. Find text in a book by tapping Find on the pop-up menu.
Enter the word you want to search for, and tap the desired Find option.
Reader highlights found text on the page. To close Find, tap outside the box.
To return to your original page, tap the title and then tap Return on the
popup menu.

o Copy Text. You can copy text from books that support this feature into any
program that accepts text. On a book page, select the text you want to
copy. Then, tap Copy Text on the pop-up menu. The text can be pasted into
the program of your choice.
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e Bookmarks. When you add a bookmark to a book, a color-coded bookmark
icon appears in the right margin. You can add multiple bookmarks to a book.
Then, from anywhere in the book, tap the bookmark icon to go to the
bookmarked page.

« Highlights. When you highlight text, it appears with a colored background.

e Notes. When you attach a note to text, you enter the text in a note pad that
appears on top of the book page. A Note icon displays in the left margin. To
show or hide the note, tap the icon.

e Drawings. When you add a drawing, a Drawing icon appears in the bottom-
left corner of the page and drawing tools appear across the bottom of the
page. Draw by dragging your stylus.

NOTE: To see a list of a book’s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’s cover page.
You can tap an entry in the list to go to the annotated page.

Removing a Book

When you finish reading a book, you can delete it to conserve space on your
V36. If a copy of the book is stored on your PC, you can download it again at
any time.

To remove a book from your V36, press and hold the title in the Library list, and
then tap Delete on the pop-up menu.
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Other Programs

The following programs are permanently installed in your V36:

Program How to Access the Program

Infrared On the Start menu, tap Programs and then tap the

Receiver Infrared Receive icon. Infrared Receive establishes the
connection between your V36 and the IR device.

Terminal On the Start menu, tap Programs and then tap the

Services Terminal Services icon. Terminal Services allows you to
access the programs and documents in a Windows NT server
type PC that is running Terminal Services.

Backup On the Start menu, tap Programs and then tap the Backup
icon. Backup enables you to back up all data stored in the
internal (RAM) memory on your V36. For more information,
see section “Backing up Data” in Chapter 3.

You can also install the following programs from the V36 Companion CD:

Program Description

Clearvue™ Allows you to view presentations created
Presentation with Microsoft PowerPoint 97, PowerPoint
Viewer 2000, and PowerPoint 2002 (XP).
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Id Pocket Internet Explorer

This chapter tells you about Microsoft Pocket Internet Explorer, Mobile Favorites
Folder and AvantGo Channels.

Using Pocket Internet Explorer

Use Microsoft Pocket Internet Explorer to view Web pages by doing the
following:

e During synchronization with your PC, download your favorite links and
mobile favorites that are stored in the Mobile Favorites subfolder in Internet
Explorer on the PC.

To start Pocket Internet Explorer:

e On the Start menu, tap Internet Explorer. The Pocket Internet Explorer
home page:

il | Mo\ dhafaudt hitm | @

[ a Micioaofl
Pocket Internet Explorer

b 2 Connected and gg
offing content

Carrier
a8 viewSonic
PocketPC.com

View Tonls 4 ﬁﬂ "'-'; Ty ml‘

— Favorites button
Home button
Refresh button
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Viewing Mobile Favorites and Channels

1 Tap the Favorites button to display your list of favorites.

2 1In the list, tap the page you want to view.

E Internet Explorer  +5 ={§ 4:51 @

Favuriles

et Mokl Fovoribes
A rvannso Channels
W hash mobile
I® Pocket PC web Gude
(*) Pockiet PC.com
& WindowsMedacom

——— Tap the Favorite you want to view.

ioen | add joskte | ———————————— Tap to add or delete a
m- folder or Favorite link.

You will see the page that was downloaded the last time you synchronized with
your PC. If the page is not on your V36, it will be dimmed in the Favorites list.
You will need to synchronize with your PC again to download the page to your
V36, or connect to the Internet to view the page.

Browsing the Internet

To connect and start browsing, do one of the following:

* Tap the Favorites button, and then tap the favorite you want to view.

* Tap View, and then tap Address Bar. In the address bar that appears at
the top of the screen, enter the Web address you want to visit and then tap
Go. Tap the arrow to choose from previously entered addresses.

The Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder in
Internet Explorer on your PC will be synchronized with your Pocket PC. This
folder is created automatically when you install ActiveSync.
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Favorite Links

During synchronization, the list of favorite links in the Mobile Favorites folder on
your PC is synchronized with Pocket Internet Explorer on your V36. Both
computers are updated with changes made to either list each time you
synchronize. Unless you mark the favorite link as a mobile favorite, only the
link (and not the page) will be downloaded to your V36, and you must connect
to your ISP or network to view the content. For more information on
synchronization, see ActiveSync Help on your PC.

Mobile Favorites

If you are using Microsoft Internet Explorer 5 or later on your PC, you can
download mobile favorites to your V36. When you synchronize your PC and
V36, the content of your mobile favorites is downloaded to your V36 so that you
can view pages while you are not connected to your ISP or your network.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.

To create a mobile favorite:

1 In Internet Explorer on your PC, click Tools, and then click Create.
*To change the link name, enter a new name in the Name box.

*To change how often the mobile favorite is updated, select a desired update
schedule under Update.

2 Click OK. Internet Explorer downloads the latest version of the page to
your PC.

3 If you want to download the pages that are linked to the mobile favorite you
just created, right-click the mobile favorite and then click Properties. On
the Download tab, specify the number of links deep you want to download.
To conserve memory on your V36, download only one level of links.

4 Synchronize your V36 and PC. Mobile favorites that are stored in the Mobile
Favorites folder in Internet Explorer are downloaded to your V36.

NOTE: If you do not specify an updated schedule, you must manually download
content to keep the information updated on your PC and V36. Before
synchronizing in Internet Explorer or your PC, click Synchronize on the Tools
menu. You will see the last time content was downloaded to your PC, and you
can manually download if needed.

NOTE: You can add a button to the Internet Explorer toolbar for creating
mobile favorites. In Internet Explorer on your PC, on the View menu, click
Toolbars, and then click Customize.

Conserving Memory

Mobile favorites take up storage memory on your V36. Follow these tips to
minimize the amount of memory used:
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Use ActiveSync settings to turn off pictures and sounds for the Mobile
Favorites information type or to stop some mobile favorites from being
downloaded to your V36. For more information, see ActiveSync Help.

Limit the number of downloaded linked pages. In Internet Explorer on the
PC, right-click the mobile favorite you want to change, and then click
Properties. On the Download tab, specify O or 1 for the number of linked
pages you want to download.

Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo channels
directly from your V36. Then you synchronize your V36 with your PC or connect

to

the Internet to download the content. For more information, visit the

AvantGo Web site.

To
1

2

sign up for AvantGo:

In ActiveSync options on the PC, turn on synchronization for the AvantGo
information type.

In Pocket Internet Explorer on your V36, tap the Favorites button to display
your list of favorites.

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your V36

with your PC, and then tap the My Channels button to complete the
AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list

of

favorites to see a few of the most popular channels. To add or remove

channels, tap the Add or Remove link.
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H Getting Connected

This chapter explains how to connect your V36 to the Internet or to a network
using a wireless connection. In addition, the chapter explains how to connect
with other mobile devices or to your PC using an infrared (IR) connection.

Connecting to a Network or the Internet

You can connect to a wireless network at work or at home by installing an SDIO
802.11B (Wi-Fi) network card (purchased separately) into the V36’s SDIO slot.

e With Pocket PC 2003, when you insert the Wi-Fi card, Microsoft’'s Zero
Configuration Wi-Fi wizard automatically lunches, assisting you to configure
your Wi-Fi easily to any wireless local area network.

e Once connected to a network, you can send and receive email messages
using Inbox and/or access web pages on the Internet using Pocket Internet
Explorer.

Creating a Wireless Connection

You will need a Wi-Fi SDIO network card (purchased separately). For
instructions on inserting and using it, see the owner’s manual for the card.

NOTE: Make sure your SDIO card is compatible with SDIO Now! technology,
developed by bSquare Inc.

To configure your Wi-Fi card, to the following:
1 Insert the Wi-Fi card into the V36’s SDIO slot.
Microsoft's Zero Configuration Wi-Fi wizard will automatically launch.

2 Follow the on-screen instructions. See the illustration on the top of the next
page.

Most networks use DHCP, so you should not have to change settings unless
your network administrator instructs you to do so.
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Microsoft’'s Zero Configuration Wi-Fi wizard
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Step 1: Multiple Networks Step 2: Enter WEP Key:

Detected: If necessary, enter the WEP
Select the name of your key.

network’s SDIO and select
either Internet or Work.

If you can not find the wireless network that you want to connect to, you can
enter it manually by doing the following: (See the illustrations on the top of the
next page.)

1

Tap Settings on the Multiple Networks Detected wizard screen (see the

“Step 1” illustration above). Or, tap the Connections icon ( gtor &, ), tap
Setting, tap the Advanced tab, then tap Network Card.

For the next three steps, see the illustrations at the top of the next page.
2 Tap Add New Settings...

3 Enter the network name (SSID).

4 1If you need to enter the Network key, tap the Authentication tab.

0 N o O

Otherwise, go to step 7.

Uncheck “The key is provided to me automatically.”

Enter the Network key (WEP key).
Tap OK on the top right corner of the screen.

Tap OK again to exit.
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Tap Add New Settings...

Enter network name.

Tap Authentication tab.

NOTE: If your network does not use DHCP, do the following:

1 Tap Start (on the V36 Windows desktop).

2 Tap Settings.

3 Tap the Connections tab.

4 Tap the Connection icon.

5 Tap the Advanced tab.

6 Tap Network Card.

7 Tap the Network Adapters tab.

8 Tap the name of your Wi-Fi card.

9 Enter the IP information provided by your company’s network administrator.
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Using an Infrared Connection

An infrared (IR) connection will allow you use your V36 to exchange information
(such as contacts and appointments) with other mobile devices as well as your
PC. (For more information, see “Using Microsoft ActiveSync” in Chapter 4.)

Use the infrared (IR) port on the V36 to exchange (send/receive) files with
another mobile device.

Sending Information

1 Switch to the program in which you created the item you want to send then
locate the item in the list.

2 Align the IR ports so that they are unobstructed and within a close range.

CAUTION: If the devices are too far apart or if something blocks the
path between the two ports, data might not be sent or received
correctly.

3 Press and hold the item, then tap Beam Item on the pop-up menu.

NOTE: You can also send items, but not folders, from File Explorer. Press and
hold the item you want to send, then tap Beam File on the pop-up menu.

Receiving Information
1 Align the IR ports so that they are unobstructed and within a close range.

2 Tap [, tap Programs, then tap Infrared Receive.

3 Have the owner of the other device send the information to you. Your V36
will automatically receive it.

72 ViewSonic Pocket PC V36



ﬂ Troubleshooting and
Maintenance

This chapter gives solutions to common problems you may encounter when
using your V36. It also provides guidelines on taking care of your V36.

NOTE: If you encounter a problem you cannot solve, contact your reseller or
ViewSonic Customer Support. See the "Customer Support” section at the end of
this chapter.

Resetting the V36 (warm boot)

CAUTION: Resetting will cause unsaved data to be lost.

Resetting your V36 is similar to restarting your PC. It restarts the operating
system, and you will lose any unsaved data. Occasionally, you may need to
reset your V36. For example, you should reset your V36:

e After you restore data from your PC.

e When your V36 stops responding. (In other words, it appears to be “frozen”
or “locked up.”)

To reset your V36, do the following:

© If you have a memory card or a 802.11b Wi-Fi card inserted in the SD/SDIO
slot, remove it before preceding further.

@ Unscrew the cap at the top of the stylus and use the pointed tip of the cap
to press the reset button. The reset button is located inside of a small
opening on the back of the V36 next to the battery compartment. See the
illustration on the next page.

See the illustration on the next page.
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Resetting the system (warm boot)

Restoring Factory Defaults (cold
boot)

In some cases, you may need to restore your V36 to the factory default settings
by clearing the memory (RAM) from your V36. For example, you should clear
the memory:

e When your V36 does not respond after being reset (warm boot described on
the previous page).

* When you forget your password.

Clearing the memory means all data you have entered in RAM, including all

files, system settings, and additional programs you have installed, will be
erased. (Programs installed to ROM at the factory are not affected.)

CAUTION:

* To ensure the integrity of your data should it be necessary to clear
the memory, you are advised to regularly back up to your Pocket PC
(using ActiveSync), or to an optional SD card (using the backup
application). For more information on backing up data, see “"Backing
Up Data” in Chapter 3.

* Do not move the battery switch unless it is necessary.
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To clear the memory from your V36, do the following:

@ Make sure that the V36 is turned off, disconnect all cables (including the AC
adapter) and if applicable, remove the SD Memory card or 802.11b SDIO card

from your V36.

Then, slide battery lock switch to the unlocked (down) position. See the
illustration below.

@ Remove the battery compartment cover.
© Unscrew the cap at the top of the stylus.

O Use the pointed tip of the cap to slide the battery switch to the OFF (left)
position, the ON (right) again.

© Replace the battery compartment cover.
@ Side battery lock switch to the locked (up) position.

The Notification indicator will flash red for approximately 30 seconds, and
then your V36 will automatically turn on and display the Welcome Wizard
screen.

(e ‘ﬁ_f':!

Remove battery
compartment cover

BPELTRAF

Replace battery
compartment cover

NOTE: If the battery runs completely out of power and is not re-charged in
time, the memory of your V36 will be cleared.
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Power Problems

Power does not turn on when using battery power

e The remaining battery power may be too low to run your V36. Connect the
AC adapter to your V36 and to external AC power. Then, turn on your V36.
(Charge the battery whenever possible to avoid running out of battery
power.)

Battery runs out of power quickly

¢ You might be using your V36 in ways that drain power quickly. (See
“Managing Power” in Chapter 3 for tips on saving power.)

Memory Problems

If a warning message of not enough memory appears due to the memory
allocation problem, try the following to free memory on your V36.

CAUTION: Be discreet when you delete files. Deleting files of which the
function is unknown can cause programs or features to malfunction. It
is recommended that you to create a backup before deleting files.

o Delete files you no longer need. Tap [, Programs, and then File Explorer.
Press and hold the file you wish to delete, then tap Delete on the pop-up
menu. To find your largest files, tap [ then Find. In the Type list, tap
Larger than 64KB, then tap Go.

¢ Remove programs you no longer need. Tap Efand then Settings. Tap
System tab, then tap Remove Programs. Tap the program you want to
remove then tap Remove.

o In Internet Explorer options, delete all files then clear history. In Internet
Explorer, tap Tools then Options. Tap Delete Files then Clear History.

* If you are copying files from a computer or other device to your V36, try
adjusting the slider in the Memory setting. Tap EF then Settings. Tap
System tab, then tap Memory. Check to see if you can manually move the
slider before copying files.

Stop programs you are not currently using. In most cases, programs
automatically stop to free needed memory. However, in some situations, such
as when confirmation dialog boxes are waiting for a user response, the program
may not be able to automatically stop. To check the state of your active
programs, tap [ then Settings. Tap System tab, tap Memory, then Running
Programs. Tap the program you want to view then tap Activate. Close any
open windows or messages and return the program to list view. If this does not
work, you can stop the program manually. First, make sure that your work is
saved by closing open items and return the program to list view. Then, stop the
program by tapping Stop or Stop All on the Running Programs tab.

Reset your V36 as described earlier in this chapter.
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If you have an SD card, move data to the SD card as follows:

¢ Tap [F], Programs, then File Explorer. Press and hold the file you want to
move, then tap Cut. Browse to My Documents folder in the SD card folder,
tap Edit, then Paste. Files stored in folders other than My Documents or
stored in subfolders within subfolders in My Documents may not show up in
the list view of some programs. When using Notes, Pocket Word, or Pocket
Excel, you can also move files by opening the item then tapping Tools or
Edit then Rename/Move.

Files stored in folders other than My Documents or stored in subfolders
within subfolders in My Documents may not show up in the list view of some
programs. When using Notes, Pocket Word, or Pocket Excel, you can also
move files by opening the item then tapping Tools or Edit then Rename/
Move.

Screen Problems

Screen is off

If the screen does not respond, even after you press the power button, try the
following until the problem is solved:

e Connect the AC adapter to your V36 and to external AC power, then

e Reset your V36 as described in “Resetting Your V36" earlier in this chapter.

Screen responds slowly

e Make sure that your V36 is not running out of battery power or running
many active programs. If the problem still exists, reset your V36 as
described in “Resetting Your V36" earlier in this chapter.

Screen freezes
e Reset your V36 as described in “Resetting Your V36" earlier in this chapter.

Screen is hard to read
e Make sure that the backlight of the display is on.
e Move to a location with enough light.

e If you are having a hard time reading a document on the screen, try
adjusting the zoom percentage or text size.

- In Notes, tap Tools and select a zoom percentage.

- In Pocket Word and Pocket Excel, tap View, tap Zoom then select a zoom
Percentage.

- In Pocket Internet Explorer, tap View, tap Text Size then select a size.

- In Calendar, Contacts, and Tasks, tap Tools, tap Options then select User
large font.
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Inaccurate response to stylus taps

Realign the touch screen. Tap Efand tap Settings. Tap System tab then tap
Align Screen. If you cannot realign the touch screen, turn off the V36. Press
and hold the scroll dial, then press the power button to turn on the V36. You

should now be able to start the touch screen alignment process.

Connection Problems

USB Cradle Connection Problems

* Make sure that you have installed the correct version of ActiveSync on your
desktop PC. Install the version ActiveSync included with your V36.

* Make sure that your V36 and your desktop PC are turned on.
* Make sure that you do not have any other active connections.
e When using the USB cradle, make sure that your V36 is properly seated.

* Make sure that the cable is securely plugged into the USB port on your
desktop PC. Connect the USB cable directly to your desktop PC — do not run
the cable through a USB hub.

* Make sure that the USB connection is enabled in ActiveSync on your desktop
PC. If the USB connection is already enabled, disable the USB connection,
close the Connection Settings window, and then reopen and re-enable the
USB connection.

e Reset your V36 before connecting the USB cable. (See “Resetting Your V36"
earlier in this chapter.) Always disconnect your V36 before you restart your
desktop PC.

e Connect only one V36 or personal digital assistant to your desktop PC at
a time.

Network Connection Problems

* Make sure that the SDIO network card is compatible with your Pocket PC
V36 (compatible with SDIO Now! technology, developed by bSquare Inc.)

* Make sure that you have installed the proper drivers for your V36.

e In the Properties for your network card, make sure that you have correctly
configured the IP settings, and the addresses of your DNS servers and/or
WINS servers. Your network administrator can verify this.

e Make sure that you have added necessary server information. Tap g and
then Settings. Tap the Connections tab, tap Connections, tap
Advanced, tap Network Card, then tap Network Adapters. Tap the
name of the installed network card (usually the card’s name) and enter any
necessary information. Most networks use DHCP to assign IP addresses
dynamically; you should not have to change or enter any IP address unless
you network administrator instructs you to do so.

o Verify with your network administrator that your user name and password
are correct.
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Verify with your network administrator that the network you are trying to
connect to is available, or try to connect to it from another computer.

You may need to change the device name if you are trying to connect to a
network and cannot because another device with the same name is already
connected. To change the device name, tap [fand then Settings. Tap the
System tab, tap About, and then tap the Device ID tab.

Infrared Connection Problems

Transfer only one file, or no more than 25 contact cards, at a time.

Position the IR ports so that they line up at a distance less than 20 cm (8
inches) but more than 5 cm (2 inches) apart.

Make sure that there are no obstacles between the two IR ports.

Adjust the room lighting. Some types of light interfere with IR
communications. Try moving to a different location or turning off some
lights.

Care and Maintenance

Taking good care of your V36 will ensure trouble-free operation and reduce the
risk of damage to your V36.

General Guidelines

Keep your V36 away from excessive moisture and extreme temperatures.

Avoid exposing your V36 to direct sunlight or strong ultraviolet light for
extended periods of time.

Do not place anything on top of your V36 as this may damage the display.
Do not drop your V36.
Store your V36 in a protective case when not in use.

The screen surface is easily scratched. Use only the stylus to tap on the
screen. Avoid touching it with your fingers, pens, or pencils.

Never clean your V36 with the power on. Use a soft, lint-free cloth
moistened with water to wipe the screen and the exterior of your V36.

Never use paper towels to clean the screen.

Travel Guidelines

Before traveling with your V36, back up your data. As an added precaution,
bring along a backup copy.

Turn off your V36 and disconnect all external devices.
Make sure that the battery is fully charged.

Take the AC adapter with you. Use the AC adapter as the power source and
as a battery-recharger.

ViewSonic Pocket PC V36 79



Hand-carry your V36 in a protective case.

Consult the airlines first before using your V36 on the plane. You need to be
very careful when using electronic devices during the flight.

If you plan to travel abroad with your V36, consult your dealer for the
appropriate AC adapter for use in your country of destination.
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Customer Support

For technical support or product service, see the table below or contact your
reseller.
IMPORTANT:

e You will need to provide the product serial number (on the back of
the V36).

¢ Before sending the V36 out for service, be sure to backup all data
and remove all third party software. See the Data Loss Disclaimer in
the Appendix

Country/ . . T = Telephone
Region Website / Email F = FAX
United States www.viewsonic.com/support T: (800) 688-6688
vstech @ viewsonic.com F: (909) 468-1202
Canada www.viewsonic.com/support T: (800) 688-6688
vstech @ viewsonic.com F: (909) 468-1202
United Kingdom  |www.viewsoniceurope.com T: 0800 833 648
service.eu @ viewsoniceurope.com |F: 01794 500801
Europe, Middle www.viewsoniceurope.com Contact your reseller
East, Baltic service.eu @ viewsoniceurope.com

countries, and
North Africa

Australia and New |www.viewsonic.com.au T: +61 2 9929 3955

Zealand service.au @ viewsonic.com F: +61 2 9929 8393

Singapore/India www.viewsonic.com.sg T: 65273 4018

ind Southeast service.sg @ viewsonic.com F: 65 273 1566

sia

Other Asia/Pacific |www.viewsonic.com.tw T: 886 2 2246 3456

countries service.ap @ viewsonic.com.tw F: 886 2 8242 3668

South Africa www.viewsonic.com/asia T: 886 2 2246 3456
service.ap @ viewsonic.com F: 886 2 8242 3668
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m Appendix

Regulatory and Safety Information

Class B Regulations

C Tested to Comply
With FCC Standards

FOR HOME OR OFFICE USE

USA

This equipment complies with the limits for a class B digital device as specified
in Part 15 of FCC Rules which provide reasonable protection against harmful
interference in a residential area. This equipment generates and uses radio
frequency energy, and if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. In the unlikely event that there is interference to radio or television
reception (which can be determined by turning the equipment off and on), the
user is encouraged to try to correct the interference by one or more of the
following measures:

e Reorienting or relocating the receiving antenna (radio or television).
e Relocating the equipment with respect to the receiver.
e Consult your dealer or an experienced radio/television technician.

e Any changes or modifications to the equipment not expressly approved by
the manufacturer could void the user's authority to operate this equipment.

e Use of a shielded interface cable is required to comply with the Class B limits
of Part 15 of FCC rules.

Canada

This Class B digital apparatus meets all requirements of the Canada
Interference-Causing equipment regulations.

Cet appareil numérique de Classe B respecte toutes les exigences du
Réglement Canadien sur le matériel brouileur.
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European Regulatory Notice

Products with the CE mark comply with both the Electromagnetic Compatibility
Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) - as
mandated by Directive 93/68/ECC - issued by the Commission of the European
Community.

Compliance with these directives implies conformity to the following European
standards:

EN55022: Radio disturbance characteristics

EN55024: Immunity characteristics

EN6100-3-2: Limits for harmonic current emissions

EN6100-3-3: Limitation of voltage fluctuation and flicker in low-voltage
supply system

EN60950: Product Safety

Battery Replacement

A Lithium Ion battery in this Pocket PC maintains system configuration
information. In the event that the battery fails to maintain system
configuration, we recommend that you contact ViewSonic Customer Support.

WARNING: This unit contains a Lithium lon battery that is user-
replaceable. To reduce risk of fire or burns, do not disassemble,
crush, puncture, or dispose of the battery in fire or water.
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About the AC Adapter

CAUTION: Only use the AC adapter (PHIHONG, PSCO5R-050) supplied
with your Pocket PC V36. Use of another type of AC adapter will result
in malfunction and/or danger.

NOTE: This product is intended to be supplied with a Listed Power Unit marked
“LPS” and output rated +5V, 1A DC / 900 mA.

The AC adapter is designed to ensure your personal safety and to be compatible
with this equipment. Please follow these guidelines:

e Do not use the adapter in a high moisture environment. Never touch the
adapter when your hands or feet are wet.

e Allow adequate ventilation around the adapter. Avoid locations with
restricted airflow.

e Connect the adapter to a proper power source. The voltage and grounding
requirements are found on the product case and/or packaging.

e Do not use the adapter if the cord becomes damaged.

e Do not attempt to service the unit. There are no serviceable parts inside.
Replace the unit if it is damaged or exposed to excess moisture.

About Electrostatic Discharge

Electrostatic Discharge Warning

Electrostatic discharges can interfere with the normal functioning of electronic
devices. Your Pocket PC can behave abnormally owing to such an event,
resulting in the possible data corruption or loss of unsaved data. To recover
from this, reset your Pocket PC as described in this User Guide.

NOTE: To avoid losing data due to electrostatic discharges or other types of
events, it is recommended that you regularly save and backup data as
described in this User Guide.
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Limited Warranty
Pocket PC Products
What the warranty covers:

ViewSonice warrants its Pocket PC products to be free from defects in material and workmanship during
the warranty period. If a Pocket PC product proves to be defective in material or workmanship during the
warranty period, ViewSonic will, at its sole option, repair or replace the product with a like product.
Replacement product or parts may include remanufactured or refurbished parts or components.
ViewSonic provides no warranty for the third party software included with the product. For specific
warranty information, please see the EULAs included with the product. ViewSonic does not warrant that
software will meet your requirements or that operation of software will be uninterrupted or error free.
VIEWSONIC AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES AND CONDITIONS, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT.

How long the warranty is effective:*
ViewSonic Pocket PCs are warranted for one (1) year for all parts (except software) and one (1) year for
all labor from the date of the first consumer purchase.

Who the warranty protects:
This warranty is valid only for the first consumer purchaser.

What the warranty does not cover:
1. Software
2. Any product on which the serial number has been defaced, modified or removed.
3. Damage, deterioration or malfunction resulting from:
a. Accident, misuse, neglect, fire, water, lightning, or other acts of nature, unauthorized product
modification, or failure to follow instructions supplied with the product.
. Repair or attempted repair by anyone not authorized by ViewSonic.
. Damage to or loss of any programs, data or removable storage media.
. Software or data loss occurring during repair or replacement.
. Any damage of the product due to shipment.
Removal or installation of the product.
. Causes external to the product, such as electrical power fluctuations or failure.
. Use of supplies or parts not meeting ViewSonic’s specifications.
Normal wear and tear.
Any other cause which does not relate to a product defect.
4. Removal installation, and set-up service charges.

How to get service:

1. Forinformation about receiving service under warranty, contact ViewSonic Customer Support. You
will need to provide your product’s serial number.

2. To obtain service under warranty, you will be required to provide (a) the original dated sales slip, (b)
your name, (c) your address, (d) a description of the problem, and (e) the serial number of the
product.

3. Take or ship the product freight prepaid in the original container to an authorized ViewSonic service
center or ViewSonic.

4. For additional information or the name of the nearest ViewSonic service center, contact ViewSonic.

Limitation of implied warranties:

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WHICH EXTEND BEYOND THE DESCRIPTION
CONTAINED HEREIN INCLUDING THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

Exclusion of damages:

VIEWSONIC’S LIABILITY IS LIMITED TO THE COST OF REPAIR OR REPLACEMENT OF THE PRODUCT.

VIEWSONIC SHALL NOT BE LIABLE FOR:

1.  DAMAGE TO OTHER PROPERTY CAUSED BY ANY DEFECTS IN THE PRODUCT, DAMAGES BASED
UPON INCONVENIENCE, LOSS OF USE OF THE PRODUCT, LOSS OF DATA, LOSS OF TIME, LOSS
OF PROFITS, LOSS OF BUSINESS OPPORTUNITY, LOSS OF GOODWILL, INTERFERENCE WITH
BUSINESS RELATIONSHIPS, OR OTHER COMMERCIAL LOSS, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

2. ANY OTHER DAMAGES, WHETHER INCIDENTAL, CONSEQUENTIAL OR OTHERWISE.

3. ANY CLAIM AGAINST THE CUSTOMER BY ANY OTHER PARTY.

Effect of state law:

This warranty gives you specific legal rights, and you may also have other rights which vary from state to

state. Some states do not allow limitations on implied warranties and/or do not allow the exclusion of

incidental or consequential damages, so the above limitations and exclusions may not apply to you.

Sales outside the U.S.A. and Canada:

For warranty information and service on ViewSonic products sold outside of the U.S.A. and Canada,

contact ViewSonic or your local ViewSonic dealer.

* For Europe: This Limited Warranty is effective in Europe for two (2) years for all parts (except
software) and two (2) years for all labor from the date of the first consumer purchase.

ViewSonic Pocket PC Warranty (V1.0) Release Date: September 9, 2002

TS Qtht0 o0
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Specifications

Processor Processor Intel X-Scale PXA255
Speed 300 MHz
Cache 32 KB Data, 32 KB Instruction
Memory RAM 64 MB SDRAM (57 MB user-accessible)
ROM 32 MB NAND Flash memory
Operating System Microsoft Pocket PC 2003 Premium Edition
LCD Screen Type Transflective TFT
Luminance 70 Cd/m2 (Nits) typical
Backlight 6 LEDs
Resolution 320 x 240
Screen Size 3.5 inches
Colors Up to 64K colors
Video Chip Media Q
Audio Features Voice Recording (Mono)
MP3 Playback support
SD Card Slot Supports SD memory and SDIO Now!
compatible card
Input/Output Digital Camera 300K pixels
Touch Panel Resistive Touch Panel
Input Method Stylus pen, On-Screen keyboard, and
Handwriting recognition software
Microphone Built-in (mono)
Speaker Built-in
Headphones 3.5 mm mini jack
usB USB 1.1 (Client) for ActiveSync
Infrared IrDA (SIR, 115.2 kbps)
Serial UART 16650 for ActiveSync
Cradle 22 pin cradle connector
AC/DC 5V, 1A, DC jack
Indicators Color LED Amber -- charging; Green -- fully charged
Red (blinking) -- notification
Power Battery Lithium lon, 900 mAh
Active Mode: up to 8 hours (with backlight Off
and camera not in use)
Suspend Mode: aprox. 14 days
Replace battery at service center.
NOTE: memory state is maintained for approx-
imately 72 hours after low battery shut-down.
AC Adapter Input: 100~240 VAC 50~60 Hz
Output: 5V DC, 1A
Recharge: 2.5~3 hours (single battery pack)
NOTE: AC adapter can be connected to main
unit or cradle.
Dimensions Physical 127.0 mm (H) x 76.8 mm (W) x 13.8 mm (D)
(Pocket PC V36) 5.0” (H) x 3.00” (W) x 0.54” (D)
Weight Net 137 g (4.8 0z)
Operating Conditions Temperature 32° F to 104° F (0° C to +40° C)
Humidity 20% to 90% RH
Storage Conditions Temperature 14° F to +140° F (-10° C to +60° C)
Humidity 20% to 90% RH

Regulations

UL/cUL, FCC Part 15 B, CE, TUV/GS, C-tick,
CCC
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Data Loss Disclaimer

Before sending the V36 out for service, be sure to backup all data and remove
all third party software.

With respect to all service provided, it is your responsibility to backup the
contents of your V36, including any data you have stored or software you have
installed on the V36. It is likely that the contents of your V36 will be lost in the
course of service and ViewSonic will not be responsible for any damage to or
loss of any programs, data or other information stored on any media or any
part of any Product serviced hereunder.

IF DURING THE REPAIR OF THE PRODUCT THE CONTENTS OF THE V36 ARE
ALTERED, DELETED, OR IN ANY WAY MODIFIED, VIEWSONIC IS NOT
RESPONSIBLE WHATSOEVER. YOUR PRODUCT WILL BE RETURNED TO YOU
CONFIGURED AS ORIGINALLY PURCHASED (SUBJECT TO AVAILABILITY OF
SOFTWARE).

Be sure to remove all third party hardware, software, features, parts, options,
alterations, and attachments not warranted by ViewSonic prior to sending the

product to ViewSonic for service. ViewSonic is not liable for any loss or damage
to these items.
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